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Patient and Physician Letters

Patient and physician letters are used to inform patients that they qualify for a medication review session, and to
inform physicians that one of their patients has undergone a medication review session. See the medication

review user guide on our website for information about conducting medication reviews in Kroll.

This user guide explains how to configure your system for patient and physician letter prompting, how to edit a
letter template, and how to generate patient and physician letters.

Patient Letters

Patient letters can be generated manually from the patient profile or automatically during workflow. This section
explains how to generate a patient letter both manually and automatically during prescription filling.

Manually Generating a Patient Letter

1. Call up the patient profile and select All Rxs from the right navigation pane.

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor Fa - Workflow I F10 - Pickup ” F11 - Drop-off " F12 - MNew Rx “ Alt-X - Start
Last Name Doe First Name Jane Salutation Ms. j N s | Petient J
Numb i
Address1 100 Yonge St Phone w (F2){Ing|(ell  girthaate 01011980 Profils
Description ‘Phone | I All Rxs I
Address 2 Age 34 years
_— ——— | Home (555) 555-5555 —_— Active Rxs
City Toronto j Prov ONj Gender Female -
— Active Rxs w/Passtimes
Postal MM 1M County Canada  ~| language English  ~ .
— Refillable Rxs
Email Send i Height 56"
L] LamibjDoctoy AN Pricing Profile
Quick Code F2 || Cl Weight 120l
£19 B [ Load | Delete | ot pisp/oTC Rus
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2. Select Medication Review/Dialogs from the right navigation pane.

Kroll

File Edit Patient Profile Reports Utilities MH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor I F9 - Workflow F10 - Pickup " F11 - Drop-off " F12 - Mew Rx " Alt-X - Start
Last Name Doe First Name Jane salutation Ms. j _ o7 save [ Patient ]
. ESC - Backto Patient  F - Refil Fi - Reprint O~ Detail -  Profile
Prafile - All Rxs (2) space - mark multiple Bxs M-Modfy  C-Cancel I - Inactivate All Ras |
# | Status | Orig A% | R Mum | Date |Agcl Oty |Auth |F|em | Brand Name | Doctar |Sig | “ I Active Rxs
1 | 1000075 1000075 12/12/2014 | 0O 31 300 | Ciprales 20mg | ZhangJemy 5 | = =
2| 9000011 9000011 12/12/2014 0 a0 300 282 MEP 360,/200/15mg Zhang,Jemy B Active Rus w/Passtimes
Refillable Rxs
= Pricing Profile
Mot Disp./OTC Rxs
Rxs Filled in Error
Suspended Rxs
Perform FDB Analysis
Alternate Addresses
- Batches
Allergies (0) [AddDg) (F2)(Ins)(0el) General | Family | Nursing Homel Copaygl Commgnicationsl Other | [ (= |
Chartin
Patient Consent | arna
Active Consent  Unknown Consent
: Credit Cards
Al |
nimal - ] Unit Dose D—
Deceased On Type <Mone> j ocuments
Medical Conditions (0) [F2] [Tns] [el] o Medication Review/Dialogs I
Prescriptions Cycle <Mone> j
. . Rx Counseling Histo
Delivery Type  Default (Pickup) j Price Group  <Default> (< None))j E——— d v
Delivery Route =] History

3. Select N - New Review/Dialog.

Refillable Rxs

File Edit Patient Profile Reports Utilities MNH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor I F9 - Workflow F10 - Pickup " F11 - Drop-off ” F12 - New Rx " Alt-X - Start
Last Mame Doe First Name Jane Salutation Ms. j _ « Save [ Patient
 Profile
N - New Review/Dialog P - Print/Reprint F - Claim Fee C - Cancel Claim Al R
F2 - View Details D - Pharmacist Declined R - Patient Refused Active R
Medication Reviews (0] FZ Del Ve s
Tupe | status | Fee Status | Created * | Completed | a | Active Rxs w/Passtimes
\ \ | | | H

4. Select the appropriate review type from the Type menu and click Save for later.

o Medication Review,Dialog

B~

LY MedsCheck Annual Review j

[ Perform Mow ] I Save for later I ’ X cancel ]
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5. A prompt will appear asking if you would like to print a “Dear Patient” letter for the selected review type.
Answer Yes.

o Medication Review Dear Patient Letter @J ﬁ

Do you want to print a "Dear Patient” letter for this patient's "MedsCheck Annual Review™?

Yes

The patient letter will generate.

Generating a Patient Letter during Prescription Filling

NOTE: In order to use patient letter functionality during prescription filling, the ‘Prompt for Medication Review
Patient Letter’ and ‘Print Medication Review Patient Letter’ workflow actions to be inserted in the appropriate
workflows. Please contact Kroll Support at 1-800-263-5876 so one of our agents can configure your system for
patient letters.

1. Callupthe F12 - New Rx screen and complete the patient, drug, prescriber, and dispensing fields. Click
F12 - Fill Now.

2. If the patient qualifies for a medication review, you will be prompted to add the patient to the medication
review queue. If the patient agrees to the medication review, select Add to Med Review Queue.

%" Select an Option B || P |

This patient may be eligible for the MedsCheck Annual Review program.

I Add to Med Review Queue I

’ Do not prompt me until the next time the patient comes in. I

’ Do not prompt until ... I

’ MNever Prompt for this patient I

’ Undecided I

Patient and Physician Letters 4
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3. A prompt will appear asking if you want to print a “Dear Patient” letter. Answer Yes.

o Medication Review Dear Patient Letter @J@

Do you want to print a "Dear Patient” letter for this patient’s "MedsCheck Annual Review™?

Yes

The patient letter will generate.

Sample Patient Letter

KROLL

Compuler $ystems Inc,

Date: 2014-Dec-15

Dear Jane Doe,
Upon review of your medication profile, it has been determined that you currently qualify for an Annual Review with one
of our pharmacists.
During this private meeting, we will:
Ensure that you completely understand your medication, what they are for and how to take them correctly.
Update our records to reflect any changes made to your medications.

Review any over-the-counter and/or herbal medications or prescriptions from other pharmacies that you are taking
and ensure that they are added to your profile in our computer system.

The review will take approximately 30 minutes and cover issues such as side effects you may be experiencing and how to
manage them, drug interactions, and the need for compliance packaging. You will receive a complete and accurate

medication list that may be taken to your physician or other health care provider.

Please speak to any of our pharmacy team today to schedule your review.

Your pharmacist: Kroll

Patient and Physician Letters 5
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Physician Letters

This section explains how to generate physician letters. Note that physicians must have a fax number listed in
their doctor profile in order to receive physician letters.

Configuring ‘No MedReview Letters’

Physicians are automatically configured to receive physician letters; however, if a physician does not want to

receive physician letters, he or she can be unenrolled from the service.
1. Callupthe F7 - Doctor profile for the selected physician.

2. Place a checkmark next to No MedReview Letter.

General - [Ecm B
Doctor Information Primary License Number Alternate License Number Prescriptions/Refills
Designation Doctor (Physician) j license 99999 License ] No kroll Care

e [ SR o E || e
Prescribing Rights Full Rights j Override [[] RefID g Override [| RefID I No MedReview Letterl
Written Language English j

Spoken Language j Signature

Patient and Physician Letters 6
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Generating a Physician Letter

Kroll®

1. Conduct a medication review session with the patient. When you are finished, click Finalize Review.

File Edit MedReview Wiew Profile Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor F2 - Workflow F10 - Pickup F11 - Drop-off F12 - New Rx Alt-X - Start
- . . * Review
MedsCheck Annual Review Reviewed With  Doe, Jane (In Person) F2
Print Medication Review
Patient  Doe, Jane Address | 100 Yonge St Select Rxs for Review
Birth  01/01/1980 | 34 years | Female | Plan| ODB Client D | 123 | Phone| Home | (555) 555-5555 | | Select Doctors for Letter
Allergies Conditions View Follow Ups
¥ View
Patient Charting
Patient Documents

| Qnestionsl Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments L

Patient Med Reviews (2)
Pharmacist Comments Al Res
Active Rxs
Active Rxs w/Passtimes
Pricing Profile
Mot Disp/OTC Profile

O

English

Francais

X save for Later

[F8 Finalize Review

2. If you have physician letter prompting enabled, a doctor letter selection screen will appear.

Select Doctors for Letter from the right navigation pane of the medication review screen.

If you do not have physician letter prompting enabled and you want to send a physician letter, click

File Edit Med Review View Profile Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow F10 - Pickup F11 - Drop-off F12 - Mew Rx Alt-X - Start
MedsCheck Annual Review

Reviewed With  Doe, Jane (In Person)

* Review

2|

Print Medication Review

Select Rxs for Review

Patient | Doe, Jane Address | 100 Yonge St
Bith | 01/01/1980 | 34 years | Female | Plan| 0DB ClientID | 123 | Phone |Home | (555) 555-5555
Allergies Conditions

Select Doctors for Letter

View Eollow Ups

“ View
Patient Charting

Patient Documents
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3. The Medication Review Doctor Letter selection screen will appear. This screen lists the doctors who

prescribed the Rxs selected for the medication review.

o Medication Review Dactor Letter selection &l@ E‘Elﬂ

Send letter to Doctars

[ 7] select [ deselect all 0/3 doctor(s) selected Ins
Doctor Fax Location Designation Specialty

[ or. Zhang, Jerry (333) 3333333 Office 2 Rxs Doctor (Physician)

[F Dr. Smith, Michael Office 1Rx Doctor {Physician)

[C Dr. Taylor, Barbara (222) 222-222 Office 1 Rx Doctor (Physician)

Medication Management Issues Found:

@ Mo medication management issues
©) Medication management issues requiring pharmacist ar patient action only, as summarized on the attached
) proposed solutions to medication management issues as indicated on the attached and summarized below

o OK

a) Place a checkmark next to the doctor(s) you want the letter sent to. To add a doctor to the list, click Ins
and perform a doctor search. The doctor will be added to the Medication Review Doctor Letter selection

screen.

o Medication Review Doctor Letter selection & E‘Elﬂ

Send letter to Doctors
Select [ deselect all 1/3 doctor(s) selected Ih
Doctor Fax Location Designation Specialty
Dr. Zhang, lerry (333) 333-3333 Office 2 Rxs Daoctor {Physician)
E or. smith, Michael Office 1 Rx Doctor (Physician)
[ or. Taylor, Barbara Office 1Rx Doctor {Physician)

Patient and Physician Letters 8
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b) Doctors that appear in grey text are not eligible to receive physician letters. This could be because ‘No
MedReview Letter’ is enabled in the doctor profile or because there is no fax number listed in the doctor

profile. Place the cursor over the doctor's name to see the reason why the doctor cannot be selected.

Doctor DOES NOT allow Medication Review Letter|

Doctor Fax Location Designation Specialty
Dr. Zhang, Jerry (333) 333-3333 Office 2 Rus Doctar (Physician)
Dr. Smith, Michael Office 1Rx Doctor (Physician)
[P Tosdos Darkarg Office 1 Rx Doctor (Physician)

Doctor Fax Location Designation Specialty
Dr. Zhang, Jerry (333) 333-3333 Dffice 2 Rxs Doctor (Physician)
Dr. Smith, Michael Office 1 Rx Doctor (Physician)
Dr. Taylor, Barbara Office 1 Rx Doctor (Physician)

c) Select the appropriate medication management issues option. If you select ‘Proposed solutions...’,

enter a summary of the proposed solutions to the medication management issues in the text box below.

Medication Management Issues Found:

) Mo medication management issues
©) Medication management issues requiring pharmacist or patient action only, as summarized on the attached
@ proposed solutions to medication management issues as indicated on the attached and summarized below

| ok

[ X cancel ]

4. Click OK.

5. The Medication Review Doctor Letter print form will appear.

Patient and Physician Letters
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Kroll®

m  Check Print store logo if you want your pharmacy’s logo to print on the letter and Print cover page if

you would like the letter to include a cover page; a Cover Page Comments tab will appear when this

option is selected.

-
o Medication Review Doctor Letter

Y= E )

Eile

Options | Cover Page Comments

Frint store logo
Frint cowver page

Printer Microsoft XPS Document Writer

Tray  Automatically Select

j Copies 1

j [¥] collate  [7] Duplex

Bestore Defaultsl [ o Erint ] [ Frewiew ] [ % Cluse]

Patient and Physician Letters
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= Enter any comments you want to appear on the cover page in the Cover Page Comments tab.

@ Medication Review Doctor Letter B)l=]=] = |

File

Options | Cover Page Comments ‘

Eont T calibri - FontSize 14 - m

;“d“’ Printer \\PRNTSRVO3\Lexma ~| Copies 15

Printer

() Fax Tray  Automatically Select j [/ collate [ Duplex
[Restore Defaults] [ " Erint ] [ Prewiew ] [ x Cluse]

m Click Preview to preview the letter or Print to print it.

Patient and Physician Letters 11
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1. Complete the review process as per usual procedures. Once complete, the physician letter will appear in

the Outbound Fax screen.

File Edit Reports Utilities NH Central Fill Cards Session Help
F7 - Doctor " Fo - Workflow “ F10 - Pickup “ F11 - Drop-off ” F12 - Mew Rx “ Alt-X - Start ]

I F3 - Patient I F5 - Drug

Last Rx Numbers

1000980
9000038 Das rd Ca 0 I ) Outbound Fax

[ Modify Rx ] Show Pending j
[ Reprint Rx ] Outbound Faxes (1) To: (122) 333-6688 Status: Waiting For Action Date
[ — ] £ On: 13/11/201415:06 On:
Cancel 3 —
— & @oom 3% @ &[0 0 & B€HE
’ Modify Specific Rx # l "
’ Reprint Specific Rx # ] el
’ Counsel Rx l
NI, o,
LI )
i1 e
Toea 0y MK kL
Caxa
L abkiTted i Ren w2 oo pad adth S i c LD E
[ —-— [
Lo ercrg 8 gy 09 pHEN ' Pacind 2 it e 000 e R et o, MANEET M
P ol O 6 e S OTEly g 1 Wk B A I (A e
o et s 1 ey e !
=t
oot S it Sreweines (4% et et vl o e aes o Bk T
Srew
KROLL -
Dispensary =) il

Generating a Physician Letter for a Completed Medication Review

1. Call up the patient profile and select All Rxs from the right navigation pane.

2. Select Medication Review/Dialogs from the right navigation pane.

Patient and Physician Letters
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3. Right-click the medication review you want to reprint the physician letter for and select Print Doctor

Letter.
Last Name Doe First Name Jane Salutation Ms. j _ Save
N - New Review/Dialog P - Print/Reprint F - Call up
F2 - View Details
Medication Reviews (1) [F2] [Inz][Del)
Type | Status |Fee Statuz Created ¥ | Completed | -
MedsCheck Annual Review Completed Electronic Penc New Medication Review M 1
Print/Reprint p
Call up F
Cancel Claim C L
Patient Refused R 1
Pharmacist Declined D
Mark Paper Review as Completed
Print Doctor Letter
View Doctor Letter History =

1. Complete steps 3-5 of the Generating a Physician Letter section.

Sample Physician Letter

KROLL

CarE b e I

Dear Dr. Zhang, Jerry

Re: Doe, Jane
100 Yonge St
Toronto ON M1M 1M1
Canada

A MedsCheck Annual Review was completed with our patient on 12-Dec-2014

Health Card Number: 123 Date of Birth: 01-Jan-1980

I am enclosing a copy of this patient’s MedsCheck Annual Review which summarizes the prescription, non-prescription and
natural products this patient is currently taking. The review also indicated that this patient has:

* Proposed solutions to medication management issues as indicated on the attached and summarized below:

text...

If you have any questions or concerns, I would be pleased to speak with your further about any of these issues
Sincerley,

Kroll Pharmacy

Patient and Physician Letters 13
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Viewing Physician Letter History

1. Call up the patient profile and select All Rxs from the right navigation pane.

2. Select Medication Review/Dialogs from the right navigation pane.

Kroll®

3. Right-click the medication review you want to view physician letter history for and select View Doctor

Letter History.

Last Mame Doe First Name Jane Salutation Ms. j _ Q/ Save
N - New Review/Dialog P - Print/Reprint F - Call up C - Cancel Claim
F2 - View Details D - Pharmacist Declined R - Patient Refused
Medication Reviews [1) Ths
Tope Status Fee Status ICreated A IEDmpIeted o
Ly SEEERS AT RIS EampleredlEIesonc en MNew Medication Review M |
Print/Reprint p
Call up F
Cancel Claim C L
Patient Refused R 1
Pharmacist Declined D
Mark Paper Review as Completed
Print Doctor Letter
View Doctor Letter History =
Allergies (0) (ddOna) (F)I0) General | pamine | mursinn mom Change Selected Rxs [ ctrl (=3

Patient and Physician Letters
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4. The History for MedsCheck Annual Review screen will appear, showing all history items associated

with the review. Click a history item to view more information.

o History for MedsCheck Annual Review aPT | B E@ﬂ

4 | 2014-12-12 15:24 User: KRL Medication Review Doctor Letter(Insert) |
-Letter printed: Prompt - Smith, Michael [Office]
i Lefter printed: Prompt - Taylor, Barbara [Office]

- Letter printed: Prompt - Zhang, Jerry [Office]
|:> -2014-12-12 15:38 User: KRL Medication Review Doctor Letter{Update)
|:> -2014-12-12 15:39 User: KRL Medication Review Doctor Letter{Update)
b -2014-12-12 15:40 User: KRL Medication Review Doctor Letter{Update)

—_———— ———— —

5. Click Close to exit the History for MedsCheck Annual Review screen.

Patient and Physician Letters 15
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Configuration

This section explains how to configure your system for patient letter and physician letter prompting and how to

edit the letter templates.

Enabling Letter Prompting

1. From the Alt-X Start screen, go to File > Configuration > Store > Rx > Counseling.

2. Check ‘Prompt to print letter’ to enable prompting for patient letters and/or physician letters.

¥ Store Level Configuration Parameters ﬁ

| ﬁenerall Eatientl Drug I Dgctorl Bx | FDB I gdiudicatinnl Labelsl Hepc-r_tsl §ecurity| 1nterfaces| Drdgrl K-AHI Y-To Dc-l [ECtrl B

| sl Generall 2- F'ricingl 3- Prnmptingl 4 - Mursing Homel 5 - Background Fix FiIIingl B -W’orkflowl - Eounseling| 8- I:eF|>:|

R Counzeling Automatic Patient Counzeling
[ Allaw editing counseling time On Mew R
Require Electronic Signaturs [] Only flag if patient hasn® had the dug in the last days
|Jzerz Permitted ta Finalize Accepted Counzeling On Fefills
Pharmacist Licenzed Technician On Drug Changss
Pharmacist [ntem Pharmacy Tech Student For Drug-Based Followups
Pharmacy Student Pharmacy Assistant Allowe Uszer bo Turmn OFF Automatic Counseling for an R=
1T Support
ua Med Reviews/Dialogs
Wizible Tabs Fequire Document Scan to Complete Paper Med Review
Hardzopy Tab R Images Tab Enablz Electronic Med Reviews
Rx Tab ‘warkflow T ab [7] Require Electranic Signature
Financial Tab Packaging Tab [] Allaws Editing Caunseling Time
_r Patient Letter 2 Physician Letter
Prampt to print letter Prompt to print letter

Edit Templates

Patient and Physician Letters 16
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Editing Patient Letter Templates
1.

2. Click Edit Templates.

Kroll &

From the Alt-X Start screen, go to File > Configuration > Store > Rx > Counseling.

¥ Store Level Configuration Parameters

===

| ﬁenerall Eatientl Dirug I Dgctc-r|

Bx | EDB I adiudicatinnl Labelsl Hepor_tsl Eecurityl 1nterfaces| Drdgrl K-AHI ¥-Ta Dc-l

| sl Generall 2- Pricingl 3- Promptingl 4 - Mursing Homel 5 - Background Fix FiIIingl [ -Wnrkflow| i- Eounseling| g- Ethvc|

R Counzeling
[] Allaws editing counzeling times
Fiequire Electronic Signature

|Jzerz Permitted to Finalize Accepted Counzeling
Licensed Technician
Pharmacy Tech Student
Pharmacy Assistant

Pharmacist
Pharrmacist Intern
Pharmacy Student

IT Support
Yizible Tabs
Hardzopy T ab Fix Images Tab
R« Tab wiorkflow Tab

Financial Tab Packaging Tab

[ ctrl (=

Autamnatic Patient Counseling
On Mew Rx
[] 0rly flag if patient hazn't had the drug in the last
On Refills
On Drug Changes
For Drug-Based Followups

dayz

Allow User to Turn OFF Automatic Counseling for an Bx

Med Reviews/Dialogs
Require Document Scan to Complete Paper Med Review
Enable Electronic Med Reviews
[ Require Electronic Signature
[T Allows Editing Counseling Time
2 Physician Letter

Prampt to print letter

Patient Latter

Prampt to print letter

Edit Templates

3. Select the letter template you want to edit and click F2, or press the F2 key on your keyboard.

o Medication Review Patient Letters

(| ]| | (51 o

Medication Reviews (11)
Medication Review

|Letter Changed On | -

General Counseling

MedsCheck Annual - LTC Home Resident
MedsCheck Annual At Home Assessment Summary
MedsCheck Annual Review

MedsCheck Diabetes Annual Assessment
MedsCheck Diabetes Follow-up Assessment
MedsCheck Follow-up - Hospital Discharge
MedsCheck Follow-up - Pharmacist's Decision
MedsCheck Follow-up - Physician / RM(EC) Referral
MedsCheck Follow-up - Planned Hospital Admission

MedsCheck Quarterly Maonitoring - LTC Home Resident

09/12/2014 183541
09/12/2014 18:35:38
09/12/2014 18:35:39
09/12/2014 183538
09/12/2014 18:35:39
09/12/2014 183539
09/12/2014 18:35:38
09/12/2014 18:35:38
09/12/2014 183538
09/12/2014 183538
09/12/2014 183539

m

Patient and Physician Letters
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4. The selected letter template will appear.

o Edit Patient Letter for "MedsCheck Annual Review"

Font T Tahoma * FontSize 10 = Variables| {StoreProv}

E] Use Store Logo || Clear

{StoreName}

{StoreAddress1}
{StoreCity} {StoreProv} {StorePostal}
{5torePhone}

Date: {Date}

Dear {PatientFirstName} {PatientLastNamel,
Upon review of your medication profile, it has been determined that you currently qualify for an Annual Review with one of our
pharmacists.
During this private meeting, we will:
Ensure that you completely understand your medication, what they are for and how to take them correctly.
Update our records to reflect any changes made to your medications.

Review any over-the-counter and/or herbal medications or prescriptions from other pharmacies that you are taking and
ensure that they are added to your profile in our computer system.

The review will take approximately 30 minutes and cover issues such as side effects you may be experiencing and how to
manage them, drug interactions, and the need for compliance packaging. You will receive a complete and accurate medication
list that may be taken to your physician or other health care provider.

Please speak to any of our pharmacy team today to schedule your review.

7o

m

a) Use the text editing tools along the top of the screen to make any necessary formatting changes.

o Edit Patient Letter for "MedsCheck Annual Review"

B3]

Font T Tahoma ~ FontSize 10 ~

Variables | {StoreProv}

) fm]

E] Use Store Logo || Clear

{StoreName}

-

Patient and Physician Letters
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b) Click ‘..." to add a store logo. Locate the logo file in your local system and click Open. Or, if you have a

store logo loaded in Reports > General, click Use Store Logo.

B2~
Wariables v]

-

o Edit Patient Letter for "MedsCheck Annual Review”

Font T Calibri - FontSize 11l - u

m Use Store Logo I Clear]

{StoreName}
K R O L L {StoreAddress1}

Cempuler Systems b=l | retareCity} {StoreProv} {StorePostal}
{StorePhone}

c) To add variable text, place your cursor where you would like the variable text to appear in the letter.

Select the variable type from the Variables menu and click Ins.

o Edit Patient Letter for "MedsCheck Annual Review" ﬂ
Font ' Tahoma ¥ FontSize 10 = Wariables) {PatientCountry} A E
{PatientPostal} -
{PatientProv} i
E] Use Store Logo {PatientQuickCode}
{PatientSalutation} |:
{StorEName} {PharmacistName} o
K R O L L {StoreAddress1} {StoreAddress1)
Compuler Syslems ne| | [ StareCity} {StoreProv} {StorePostal} StoreAddress2}
{StorePhone} [StoreAltFax} %

Date: {Date}

m

Dear {PatientFirstName} {PatientLastNamel,

Upon review of your medication profile, it has been determined that you currently qualify for an Annual Review with one of our
pharmacists.

d) Make any necessary changes to the body text.
5. Click Preview to preview the letter and OK to save it.

6. Click Save to close the Medication Review Patient Letters screen.

Patient and Physician Letters
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